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Inside a computer, each address mask is stored asa  bit value.
a. 48
b. 64
c. 16
d. 32
The protocol address of the next hop must be to an equivalent
hardware address before a packets can be sent.

a. Encrypted

b. Decrypted

c. Translated

d. Segmented
TCP/IP define the term to refer any computer system that connects to a
network and runs applications for user.
a. Router
b. Host computer
c. Bridge
d. Switch

protocols of TCP/IP layering model specify how to ensure reliable

transfer.

a. Physical Layer

b. Network Interface Layer

c. Internet Layer

d. Transport Layer

protocols of TCP/IP layering model specify how to organize data an
how a computer translate frames over a network.
a. Session
b. Network Interface layer
c. Internet Layer
d. Transport Layer
are two standard implementations to improve computational

efficiency.

a. Hashing and Direct indexing

b. Segmentation and Fragmentation

c. Queuing and packetizing

d. Indexing and Framing
___of TCP/IP protocol suit defines the basic characteristics of network
hardware

a. Physical Layer
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b. Data link layer
c. Internet Layer
d. Transport Layer

8 Dotted Decimal represented each octet in__ and uses a dot to separate
octets.
a. Binary
b. Decimal
c. Hexadecimal
d. Octal
9 Ifthe IP address  identifies the Physical Network to which the computer
is attached.
a. Prefix
b. Suffix
¢. Mux
d. Demux
10 Mapping between a protocol address and a hardware address is called

b. Segmentation

(e

. Hashing

c. Address Resolution

o

. Fragmentation

11 protocols of TCP/IP layering model specify how to organize data
into frame and how a computer transmits frames over a network.

d. Session

b. Network Interface Layer

a Internet Layer
b Transport Layer

12 In Closed-form computation, the protocol address assigned to a computer is
chosen carefully so that computer's hardware address can be computed
from the protocol address using basic Boolean and operations.
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a. Arithmetic

a. XOR
b. Shift
c. XNOR

13 As the Internet grew, the original Classful addressing scheme became a
limitation. The IP address space was being exhausted because all networks
had to choose one of possible sizes.

a. Three

a. two
b. four

c. five

14 Dotted decimal notation is a syntactic form the [P software uses to express

binary values when interacting with humans.

b. 8-bit
c. 16-bit

c. 32-bit

d. 64-bit

15 In the IP address identifies an individual computer on the
network.
a. Prefix

b. Suffix
b. Mux

¢. Demux
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16 Internet protocol (IP) address version 4 is comprised of ------- bits.

b. 48
c. 32
d. 24
e. 128
17 A separate table is used for each physical network.
b. bit-binding

c. Checksum

(]

. address-binding

d. CRC
18. Inside a computer, each address mask is stored as a bit value.

c. 48
d. 64
e. 16
d. 32

19. Dotted decimal represents each octet in __ and uses a dot to separate octets.
a. Binary
b. decimal

b. hexadecimal
c. Octal

20. of TCP/IP Protocol Suit specifies the format of packets sent across

Internet as well as the mechanisms used to forward packets.
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c. Physical Layer

d. Data Link Layer
c. Internet Layer

d. Transport Layer
21. The IP class scheme does not divide the address space into equal

size class and the classes do not contain the same number of networks.

a. 16-bit

b. 32-bit

c. 48-bit
d. 64-bit

22. of TCP/IP protocol suit defines the basic characteristics of

network hardware.

c. Physical Layer
d. Data Link Layer
e. Internet Layer

f. Transport Layer

23. The protocol address of the next hop must be to an equivalent
hardware address before a packet can be sent.

b. Encrypted
c. Decrypted

c¢. Translated
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d. Segmented

24. Address Resolution Protocol is mostly used to bind a 32-bit IP address to a

Ethernet address.

a. 16-bit
b. 48-bit

a. 64-bit
b. 128-bit

25. TCP/IP defines the term to refer any computer system that
connects to a network and runs applications for users.
a. Router
b. Host computer

c. Bridge
d. Switch

26. are two standard implementations to improve computational
efficiency.

a. Hashing and Direct indexing
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b. Segmentation and Fragmentation

¢. Queuing and Packetizing

d. Indexing and Framing
27. A - Relies on the hardware manufacturer to assign a unique physical address to
each network interface.

P Static addressing scheme (Page 34)
» Configurable addressing scheme

» Dynamic addressing scheme

» None of the given

28. An interface for thin Ethernet must have an connector, and must
generate signals according to the specification.

» RJ-45, 10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2 (Page 21)
» BNC, 10 Base T
29. A system with redundant bridges might have a problem with in the system.
» Loop (page 50)
» Filters
» Spanning Trees
» All given choices
30. A Bridge can
» Filter a frame
» Forward a frame
» Extend a LAN

» Do all ( page 50)

31. is used for typical data applications (where the data rate may be unknown and

bursty) and allows use of whatever bandwidth is available at a given time.
» Constant Bit Rate (CBR) service

» Variable Bit Rate (VBR) service
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» Available Bit Rate (ABR) service (Page 71)

» None of the given

32. ATM assigns each VC a identifier that is divided two parts to produce a
hierarchy.
» 21-bit
» 22-bit
» 23-bit
» 24-bit (Page 67)
33. of TCP/IP layering model, corresponds to basic network hardware.
» Physical Layer (Page 84)

» Network Interface Layer
» Internet Layer
» Transport Layer
34, places the boundary between the second and third octets
» Class A
» Class B (page 86)
» Class C
» Class D
35. UDP and TCP are both layer protocols
» Physical
» Data link
» Network
» Transport (Page 101)

36. Connection-oriented service, Point-to-point, Complete reliability, Full-duplex
communication, Stream interface, Reliable connection startup and Graceful connection
shutdown are the services provided by--------------- .

> IP
» None of the given

» TCP (Page 123)
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» UDP

37. protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
P Internet Layer
» Transport Layer (Page 84)

38. identifies which application program on receiving computer should receive the
data

» Logical address
» Source port
» Destination Port (google)
» None of the given
39. identifies the application program that sent the data.
» Destination Port
» Source port (google)
P Logical address
» None of the given

40. Which of the following are interior routing protocols?

» RIP
» OSPF
» BGP
» RIP and OSPF (page 137)
41. The Border Gateway Protocol (BGP) uses for all communication
» UDP
» TCP (page 138)

» Both UDP and TCP

» None of the given
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42. measures distance in network hops, where each network between the

source and destination counts as single hop.

» BGP
» OSPF
> RIP (Page 138)
» None of the given

43. OSPFis basedon___
» Distance vector routing
P Link state routing (Page 140)
» Path vector routing
P Distance vector routing and Link state routing

44, performs local multicast and uses IP-in-IP encapsulation to send multicast
datagrams from one site on the Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP) (Page 144)
» Core Based Trees (CBT)
» Protocol Independent Multicast_ Sparse Mode (PIM-SM)
» Protocol Independent Multicast _ Dense Mode (PIM-DM)

45. The length of time required to send a variable length packet is variable and does not
require a complicated interrupt scheme to detect completion of transmission.

» True
» False (Page 72)

46. NEXT HEADER field in the base header defines type of header and it appears at end of
fixed-size base header.

» True (Page 112)

» False

47. Although message exchange can be used to bind addresses, sending a request for each
binding is hopelessly inefficient.

» True (Page 99)

» False
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48. Address mask defines how many bits of address are in suffix.

» True
» False (Page 103)

49. A computer attached to a given network can only communicate with other computers
attached to the same network. Is this a problem with multiple networks?

» True (Page 81)
» False

50. In the 1970s large organizations began to acquire multiple networks. Each network in
the organization formed island. Employees needed to choose a computer appropriate
for each task. So they needed multiple screens, keyboards and computers.

» False

» True (Page 81)

51. The term self-identifying is used for Classful IP addresses because the class of the

address can be computed from the address
» itself (Page 87)
» prefix
P suffix
» mask

52. In which method of Address Resolution Protocol the protocol address independent of
hardware address? Were "T" stands for Table lookup, "C" for Closed-form Computation
and "D" for Data Exchange?

> T,C

> D

> C

» T,D (Page 97)

53. In which method of Address Resolution Protocol the protocol address is determined by
hardware address? Were "T" stands for Table lookup, "C" for Closed-form Computation
and "D" for Data Exchange?

> T
> D

> C (Page 97)
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»T,C6

54. Reconstruction of original datagram is called reassembly.
» True (Page 28)

» False

55. A computer needs a complete stack of protocols to run either a client or a server.

» True)
» False
56. TCP uses mechanism to control the flow of data.
» door
» window (Page 126)

P acknowledgment
» retransmission FINALTERM EXAMINAT

57. In Direct point to point communication adding the Nth computer requires------------

connections.

» None of the given
>N 2
»N-1 (Page 23)
> (N2-N)/2

58. In -=-—---—-—-—- , hetwork occupies the smaller area like a room a floor or a building
> LAN (Page 4)
> WAN
» MAN
» None of the given 7

59. The third field of the header consists of ------ bit Ethernet frame type.
» 48
»32
> 16 (google)

>3
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60. The maximum size of an Ethernet segment is

» 250 meters
» 500 meters (google)
» 700 meters

» None of the given

61. The network with Throughput T and Delay D has a total --------------- bits in transit at a
time.
»D+T
»D-T
»DXT
»D/T
62. places the boundary between the first and second octets
» Class A (page 86)
» Class B
» Class C
» Class D
63. Router detects datagram --------- than network MTU and then it splits into pieces and
each piece is ---------- than outbound network MTU.
P Larger, smaller (Page 108

» Larger, larger
» Smaller, larger
» Smaller, smaller

64. Connectionless service, Message-Oriented protocol, best-effort delivery service,
arbitrary interaction & operating system independent are the characteristics of

» TCP
» UDP (Page 120)
» P

» None of the given
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65. - provide Application to application communication it also called end to end

communication
»IP
»TP (Page 119)
> RIP
» None of the given
66. A routing table contains
» The destination network ID
» The hop count to reach the network
P The router ID of the next hop (Page 102)
P All of the given
67. Which of the following protocols allows the sender and receiver to enforce polices.
> RIP
» OSPF
»BGP (page 138)

» RIP and OSPF

68. measures distance in network hops, where each network between the

source and destination counts as single hop.
» BGP
» OSPF
> RIP (Page 138)

» None of these

69. includes a 32-bits address mask with each address, which allows the address to

be classful, classless, or subnetted.
» RIP
» OSPF (Page 140)
» BGP

» None of the given 9
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70. One repeater --------------- , two repeaters -------------—- the maximum cable length
limitation.
» Double, triple (Page 49)

» Double, 4 time
P half, triple
» Double, half
71. ICMP message transport is acted upon by getting ICMP encrypted in IP.
» True (Page 117)
P False

72. Like most application programs, a client and server use a transport protocol to
communicate.

» True (Page 146)
> False

73. Mapping between a protocol address and a hardware address is called Address

Resolution.

» True (Page 93)
» False

74. Address mask defines how many bits of address are in suffix?
» True
P False (Page 103)

75. A single networking technology is best for all needs.
» True
» False (Page 81)

76. In the 1970s large organizations began to acquire multiple networks. Each network in
the organization formed island. Employees needed to choose a computer appropriate
for each task. So they needed multiple screens, keyboards and computers.

» False
» True (Page 81)

77. Router detects datagram--------- than network MTU
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» Larger (Page 108)

» Smaller
» None of given
» Equal
78. Information can flow in either or both direction between
» Clients
» Clients and servers
» Servers
» None of given
79. One of the design goals for unicast route propagation is
P> consistency
P inconsistency
P stability
» dynamic addressing
80. IPV6 address consists of
» 32 Bits
» 64 Bits
» 128 Bits (Page 128)
» none of the given

81. UDP offers application programs a Message-Oriented Interface, applications can depend
on protocol to preserve data boundaries.

» True (Page 120)
» False

82. In case TCP, retransmission, acknowledgment from a computer on LAN are expected to
arrive within

» Seconds
» Micro seconds

» Milliseconds




AL-JUNAID TECH INSTITUTE

» Nanoseconds

83. Twice NAT is another variant of NAT. it is used with site that runs server. In this process
NAT box is connected to Domain Name.

» True (Page 131)
» False
84. A network uses a ------ arranges for computers to be connected in a closed loop.
P Star Topology
P Ring Topology (Page 25)
» Bus Topology

» None of the given
85. Protocol addresses are abstractions provided by
» hardware
» software (Page 93)
» operating system
P internet

86. In Direct point to point communication adding the Nth computer requires------------ new
connections.

» None of the given
> N2
> N-1 (Page 23)
» (N2 -N)
87. In Point-to-Point topology there are two topologies.
» Tree and Ring
» Star and Ring
» Star and Tree (Page 5)
» None of the given
88. In ----------——- , hetwork occupies the smaller area like a room a floor or a building

» LAN (Page 4)
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> WAN

» MAN
» None of the given
89. CRC can detect more errors than a simple checksum.
» true ( page 80)
» false
90. The Gigabit Ethernet hardware operates at a rate of --------
» 10 Mbps
» 100 Mbps
» 1000 Mbps

» None of the given

91. Formally named informally known as the twisted pair Ethernet or TP
Ethernet.
» 10 Base 2
» 10 Base 5
> 10Base T (Page 43)

» None of the given

92. An interface for thin Ethernet must have an connector , and must
generate signals according to the specification.

» RJ-45, 10 Base T
» RJ-45,10 Base 5
» BNC, 10 Base 2 (Page 201)

» BNC, 10Base T

93. computes shortest paths in a graph by using weights on edges as a measure of

distance.
» Greedy algorithm
» Distance vector algorithm
» Dijksta’s algorithm (page 112)

» None of the given
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94. Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a .

» Connectionless service paradigm (page 112)
» Connection-oriented service paradigm
» Both Connectionless and Connection-oriented service paradigm
» None of the given
95. protocol of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer (Page 84)

96. An Internet Address (IP address) is a unique binary number assigned to a
host and used for all communication with host

P> 48-bit
» 32-bit (Page 85)
» 24-bit

» None of the given

97. The address identifies the physical network to which the computer is
attached, while the identifies an individual computer on that network.
P prefix , suffix (Page 85)

» suffix , prefix
» suffix , suffix

» None of the given

98. places the boundary between the first and second octets
» Class A
» Class B (page 88)
» Class C

» Class D
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99. places the boundary between the third and fourth octets.

» Class A
» Class B
» Class C (page 88)

» Class D

100. field of header indicates whether a datagram is a fragment or a complete
datagram.

> FLAGS
» FLAGMENT OFFSET
» IDENTIFICATION

» None of the given

101. __ provides connectionless service.
» TCP
» UDP (Page 120)
> IP

» None of the given

102. UDP and TCP are both layer protocols
» Physical
» Data link
» Network
» Transport (Page 101)

103. Connection-oriented service, Point-to-point, Complete reliability, Full-duplex
communication, Stream interface, Reliable connection startup and Graceful connection
shutdown are the services provided by

> IP
» None of the given
» TCP (Page 123)

» UDP
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104.
the data

P Logical address

» Source port

P Destination Port

» None of the given
105.

» Destination Port

» Source port

» Logical address

» None of the given

identifies which application program on receiving computer should receive

identifies the application program that sent the data.

106. The Border Gateway Protocol (BGP) uses for all communication

» UDP

» TCP

» Both UDP and TCP

» None of the given

( page 138)

107. Protocol addresses are abstractions provided by

» hardware
» software
» operating system

» internet

(Page 93)

108. These packets serve same purpose on as frames on

» Intranet, LAN
» Internet, WAN
» Intranet, WAN

» Internet, LAN

(Page 101)

109.  Address mask defines how many bits of address are in suffix?

» True
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» False (Page 103)

110.  Asingle networking technology is best for all needs.
» True
» False (Page 81)

111. A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple networks?

» True (Page 81)
» False

112.  The term self-identifying is used for Class full IP addresses because the class of the
address can be computed from the address

» itself (Page 87)
» prefix
P suffix

» mask

113.  Find the class of the address. 10100111 11011011 10001011 01101111
> A
> B (page86)
> E
> C
114.  Find the class of the address: 11110011 10011011 11111011 00001111
> A
»C
> E (page86)
> B

115.  In which method of Address Resolution Protocol the protocol address is determined
by hardware address? Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

> T
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» D
> C (Page 97
»T,C
116.  Which method of Address Resolution Protocol requires hardware broadcast? Were
"T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data
Exchange?
» D (Page 97)
>T
» C
»T,D
117.  Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data
Exchange?
»T,D
»C
> T
»T,C (Page 97)
118. In which method of Address Resolution Protocol the implimentation is more
difficult? Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?
> T,C
>T
> C
» D (Page 97)

119.  On of the design goals for unicast route propagation is
» Consistency
P inconsistency
P stability (Computer Networks and Internets, page 344) rep

» dynamic addressing
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120.  Propagation multicast routing information differs dramatically from unicast route

propagation?
» True (Computer Networks and Internets, page 335)
» False

121.  To save traffic, an EGP does not summerized routing information from the
autonomous system before passing it to another autonomous system.

» True
> False
122.  InIPv6 the type of address used for collection of computers with same prefix. Are
known as . > Anycast
» Unicast
» Multicast
» None of the given (Page 114)

123.  Special types of addresses in IPv6 used for multiple destinations; possibly not at
same site. Are known as

» Unicast

» Anycast

» Multicast (Page 114)
» None of the given

124.  UDP offers application programs a Message-Oriented Interface, applications can
depend on protocol to preserve data boundaries.

» True (Page 120)
» False
125.  Reliability is the responsibility of the layer
» Network
» Data link
» Transport (Page 123)
» Application

126. FDDI can transmits data at a rate of ----------
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» 100 million bits per second (Page 31)

» 10 million bits per second
» 1000 million bits per second
» None of the given
127.  Computer networks are often called -------------- because they use packet technology.
» Ethernet
» Switch networks
» Packet networks
» None of the given
128. A network uses a ------ arranges for computers to be connected in a closed loop.
P Star Topology
» Ring Topology (Page 25
» Bus Topology 22
» None of the given

129. An-—-——-—--—- method, the network hardware designers specify how type information
is included in the frame and the value use to identify various frame types.

» Explicit frame type
» Ideal frame type

» Implicit frame type
» None of the given

130. Aninterface for thin Ethernet must have an connector, and must
generate signals according to the specification.

» RJ-45,10Base T

» RJ-45,10 Base 5

» BNC, 10 Base 2 (Page 201)
» BNC, 10Base T

131. A Bridge forwards or filters a frame by comparing the information in its address
table to the frame’s

P Layer 2 source address
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» Source node’s physical address

P Layer 2 destination address
» Layer 3 destination address
132. protocol of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
P Internet Layer

» Transport Layer (Page 84)

133.  When an application--------------- data, it makes a copy of the data available to
all other computers on the network.

» Broadcasting

» Multicasting

» Unicasting

» None of the given

134. Ethernet uses a ------ bit static addressing scheme in which each device is
assigned a unique address by the manufacturer.

> 64
> 48
» 32
» 8

135.  The product of delay and throughput measures the of data that can be
present on the network.

» Arca
» Volume(google)

» Length
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» None of the given

136. Connectionless service, Message-Oriented protocol, best effort delivery
service, arbitrary interaction and operating system independent are the
characteristics of

» TCP
» UDP (page 120)
» IP

» None of the given

137. serve same purpose in internet as frames on LAN.
» Virtual frames
» Packet
» A and b both
e |Virtual packets (page 101)

138. A - relies on the hardware manufacturer to assign a unique physical address to
each network interface.

P Static addressing scheme (page 133)
» Configurable addressing scheme
» Dynamic addressing scheme

139.  » None of the given
An interface for thin Ethernet must have an connector , and must
generate signals according to the specification.

» RJ-45, 10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T
140. A system with redundant bridges might have a problem with in the system.
» Loop
» Filters
» Spanning Trees

» All given choices
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141. A Bridge can

» Filter a frame

» Forward a frame

» Extend a LAN

» Do all the above (page 50)
142. is used for typical data applications (where the data rate may be
unknown and bursty) and allows use of whatever bandwidth is available at a given
time.

» Constant Bit Rate (CBR) service

P Variable Bit Rate (VBR) service

» Available Bit Rate (ABR) service (page 71)
» None of the given

143. ATM assigns each VC a identifier that is divided two parts to
produce a hierarchy.

» 21-bit
» 22-bit
» 23-bit
» 24-bit

144.

of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layer (page 123)
» Network Interface Layer
» Internet Layer
» Transport Layer

145. places the boundary between the second and third octets
» Class A
» Class B
» Class C

» Class D
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146.  UDP and TCP are both layer protocols
» Physical
» Data link
» Network
» Transport (123 page)
147. protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (page 124)

148. identifies which application program on receiving computer should receive
the data

» Logical address

» Source port

» Destination port

» None of the given
149. identifies the application program that sent the data.

» Destination Port
» Source port
» Logical address

» None of the given

150.Which of the following are interior routing protocols?
» RIP (page 138)
» OSPF
» BGP

» RIP and OSPF
151.  The Border Gateway Protocol (BGP) uses for all communication

» UDP
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» TCP (138 page)

» Both UDP and TCP

» None of the given

152.  Class A mask is 255.0.0.0 which is used for
All of the given option

Unicasting

Subnetting (page 103)
Multicasting

X3

S

0,
0‘0

X3

%

X3

S

153.

OSPF is based on--------
» Distance vector routing
» Link state routing (page 140)
» Path vector routing

» Distance vector routing and Link state routing

154.

performs local multicast and uses IP-in-IP encapsulation to send multicast
datagrams from one site on the Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP) (page 144)
» Core Based Trees (CBT)

» Protocol Independent Multicast Sparse Mode (PIM-SM)

» Protocol Independent Multicast _ Dense Mode (PIM-DM)

155.  The length of time required to send a variable length packet is variable and does not
require a complicated interrupt scheme to detect completion of transmission.

» True
» False

156.

NEXT HEADER field in the base header defines type of header and it appears at end of
fixed-size base header.

» True(112 page)

» False

157.
Although message exchange can be used to bind addresses, sending a request for each

binding is hopelessly inefficient.

» True
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» False

158.  Address mask defines how many bits of address are in suffix?
» True
» False

159. A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple
networks?

» True

» False

160.

In the 1970s large organizations began to acquire multiple networks. Each network in
the organization formed island. Employees needed to choose a computer appropriate
for each task. So they needed multiple screens, keyboards and computers.

» False

» True (page 88)

161.

The term self-identifying is used for Classful IP addresses because the class of the address
can be computed from the address

» itself (page 85)
» prefix
P suffix

» mask

162.

In which method of Address Resolution Protocol the protocol address independent of
hardware address?

> T,C

> D

> C

» T, D(page 97)

163.

In which method of Address Resolution Protocol the protocol address is determined by hardware
address?
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> T

» D
» C (page 97)
> T,C

164.

Reconstruction of original datagram is called reassembly.
» True
» False
165. A computer needs a complete stack of protocols to run either a client or a server.
» True

» False

166. When an application--------------- data, it makes a copy of the data available to
all other computers on the network.

» Broadcasting

» Multicasting

» Unicasting

» None of the given

167. Ethernet uses a ------ bit static addressing scheme in which each device is
assigned a unique address by the manufacturer.

> 64
> 48
> 32
> 8

168.  The product of delay and throughput measures the of data that can be
present on the network.

» Areca
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» Volume

» Length

» None of the given

169. Connectionless service, Message-Oriented protocol, best effort delivery
service, arbitrary interaction and operating system independent are the
characteristics of

» TCP
» UDP
» [P

» None of the given

170. uses distance vector approach to define routing
» BGP
» OSPF
> RIP
» None of the given

171.  Whenever it handles a packet, IP software needs to separate the destination
address into a and

» postfix, Infix
» none of these
» Infix, prefix

» prefix, suffix

172.  ARP is almost always used to binda ___ -bit [P address toa __ -bit Ethernet
address.

» 32, 48(page 98)
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> 24, 32

> 32, 64

» 32,128

173.  Which method of Address Resolution Protocol is useful with any hardware?
> T
> C (page 97)
» D
»C,D

174.  In which method of Address Resolution Protocol the protocol address is
determined by hardware address?

> T

» D

» C(page 97)
»T,C

175.  We use the term to refer to a measure of the path that routing
software use when choosing a route.

» routing path

» routing metric
» routing

» switching

176. A network uses a ------ arranges for computers to be connected in a closed
loop.

» Star Topology
» Ring Topology
» Bus Topology

» None of the given
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177. An interface for thin Ethernet must have an connector , and
must generate signals according to the specification.

» RJ-45, 10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T

178. protocols of TCP/IP layering model specify how to ensure reliable
transfer.

» Physical Layer

» Network Interface Layer
» Internet Layer

» Transport Layer

179. uses distance vector approach to define routing

» BGP
» OSPF
> RIP

» None of the given
180. is ideal in a situation where the group is small and all members are

attached to contiguous Local Area Networks.
Flood-and -Prune
Configuration-and -Tunneling

e

S

o
0.0

o
0.0

Core-Based Discovery
% None of the given

181.  Router that decrements TTL to ___ sends ICMP time exceeded message, with
router s address as source address
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R/
0‘0 O

182.  Protocol addresses are abstractions provided by
< hardware

% software
% internet
183.  Although message exchange can be used to bind addresses, sending a request
for each binding is hopelessly inefficient.
% True
% False

184. Which method of Address Resolution Protocol is useful with any hardware?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data
Exchange?

el T (97 page)
% C
< D
“ CD
185. In which method of Address Resolution Protocol the implimentation is more
difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data
Exchange?

o T,C
% T

“ D (page 97)
186. To save traffic, an EGP does not summerize routing information from the
autonomous system before passing it to another autonomous system.
s True

<+ False

L)

187. - was especially concerned about the lack of high powered

computers.
« IEEE

< APRA
< EIA
<+ None

188. Missing eot indicates sending computer crashed in frame format.
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0‘0

7
0‘0

L)

X3

>
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True

False

189. The ------------- term refers to the general concept of a small block of data.
Packets

Frame
None of given

190. CRC can detect more errors than a simple checksum.
True

False

191.  The network that uses a ------------- , usually consist of a single long cable to
which computer attach.

» Star topology

< Bus topology (page 30)

DS

)

®,

% Ring topology

¢

*,

» None of the given

L)

192. LAN that use ATM technology have a -------------

Star topology
Bus topology
Ring topology
< None of the given (page 31)
193.  —mmmmmmmme - has a jitter zero

Virtual Private Network
Isochronous Network
Asynchronous Network
None of the given

194. The network with Throughput T and Delay D has a total --------------- bits in
transit at a time.
D+T

D-T
DXT
D/T

195. One repeater --------------- , two repeaters --------------- the maximum cable
length limitation.
Double, triple

Double, 4 time
half, triple
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< Double, half

196.  End-to-end delivery service is connection oriented.
 True

«» False

197. A single networking technology is best for all needs.
 True

<+ False

198. Twice NAT allows a site to run servers.
% True

«» False

199. device is used for multicasting.
< Hub

% Switch
% Router
% none of the given

200. does not depend on any particular unicast routing protocol.
< PIM-DM

% PIM-SM
s PIM-AM

% none of the given

201. A routing table contains
«» The destination network ID

% The hop count to reach the network
% The router ID of the next hop
% All of the given

202. can be used to propagate information about remote networks.
% Dynamic routing (page134)

% Static routing
% Address resolution
% None of the given

203. protocol is designed to use within an organization.
% OSPF

+ MEOSPF
% MOSPF (page 139)
% none of the given

204. NAPT stands for
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Network Address and Protocol Translation

)/
0.0

B3

» Network Address and Port Translation (page 132)

¢

» Network Address and Packet Translation

L)

% None of the given

205. In dynamic routing, the routing table is initialized when system boots.

% True (page 134)
«» False

206. OSPF includes address mask with each address.
% 30Bit

< 32Bit (page 140)
< 34Bit
% none of the given

207. Twice NAT fails if an application uses the IP addresses instead of Domain
Name.
¥ True(page 132)

«» False

208. uses window mechanism to control the flow of data.
< IP

< UDP
< TCP (page 128)
% none of the given

209. TCP uses mechanism to control the flow of data.
% door

< window (page 122)
% acknowledgment
% retransmission

210. IGPs stand for
< Internal Gateway Protocols

% |[Interior Gateway Protocols (page 135)
% Intermediate Gateway Protocols

% None of the given

211. protocol uses distance vector algorithm.
% IGP
< BGP
< RIP (page 139)

% None of the given
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212, measures distance in network hops, where each network
between the source and destination counts as single hop.

BGP

OSPF

RIP (page 138)

None of these
213. Network Address Translation (NAT) requires device to perform packet

translation.

True (page 128)

False

214. We use the term to refer to a measure of the path that routing
software use when choosing a route.

routing path

routing metric(page 132)
routing
switching

215.  Part of the 3-way handshake used to create a connection, requires each end to
generate a random sequence number.
32 bit

16 bit
8 bit
64 bit

216. Reconstruction of original datagram is called reassembly.
True

False

217.  Reliability is the responsibility of the layer.
Transport

Network
Physical
Internet

218. is ideal in a situation where the group is small and all members are
attached to contiguous Local Area Networks.
Flood-and —Prune (page 123)

Configuration-and -Tunneling
Core-Based Discovery
None of the given

219. In Direct point to point communication adding the Nth computer requires----
———————— new connections.
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None of the given
Nz

N-1

(N2 -N)/2

220. The number of connections needed for N computer in direct point to point
communication is equal to:
(N=-N)/2

N(N-1)
N2

None of the given

221. Hardware that calculates a CRC uses two simple components.
AND unit and XOR unit

Shift register and XOR unit (page 20)
Shift register and AND unit
None of the given

222,  The Gigabit Ethernet hardware operates at a rate of --------
10 Mbps

100 Mbps
) 1000 Mbps (page 46
None of the given

223. Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a

Connectionless service paradigm

Connection-oriented service paradigm
Both Connectionless and Connection-oriented service paradigm

None of the given

224. An Internet Address (IP address) is a unique binary number
assigned to a host and used for all communication with host
< 48-bit
% 32-bit (page 85)
< 24-bit
% None of the given

225. The address identifies the physical network to which the
computer is attached, while the identifies an individual computer on
that network.

prefix , suffix (page 85)

suffix , prefix

suffix , suffix
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% None of the given

226. Field of header indicates whether a datagram is a fragment or a
complete datagram.
< FLAGS

+ FLAGMENT OFFSET
< IDENTIFICATION
% None of the given

227.  Which of the following protocols allows the sender and receiver to enforce
polices.
< RIP

< OSPF
% BGP (page 137)
« RIP and OSPF

228. ICMP message transport is acted upon by getting ICMP encrypted in IP.
% True

s |False

229. These ICMP message transport is acted upon as frames on

+ Intranet, LAN

+ Internet, WAN
+ Intranet, WAN
« Internet, LAN

230. Address mask defines how many bits of address are in suffix?
 True

% False

231. A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple
networks?

% True

«» False

232. Find the class of the address:

11110011 10011011 11111011 00001111

(page 87)

@ = O »

233. Inside computer each address are stored as a bit value.
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% 48
%+ 64
% 16
< 32 (page 103)
234. In , the protocol address assigned to a computer is chosen carefully

so that computer’s hardware address can be computed from the protocol address using
basic Boolean and arithmetic operations.
+* Address

Resolution

*

R/
0.0

R/
0.0

Table Lookup

>

%* Message (Page 9)
235. H.LEN shows the header length in units of ___ Bits:

% 34

% 32 Page 105

< 30

** None of the given

236. End to End delivery Service of IP datagram is

+* Connection oriented

«* Connectionless Page 120
«* bothaandb

** none of the given

237. In Cyclic Redundancy Checking, CRC is

/

** Divisor
¢ Quotient
+* Remainder page 20

¢ Dividend
238. The satellite or radio topology in which all computers are connected to each other
via satellite or radio wave is a kind of
¢ Broadcast network page 5
¢ Point-to-Point network
239. The process of forwarding a packet is called

.0

% Routing page 58

X/
%

Processing

X/
%

Hierarchical Addressing

X/
%

Source Addressing

240.  Which statement is correct about Network Interface Card (NIC)?

I NIC contains sufficient hardware to process data independent of system CPU
Il NIC looks like any other 1/O device to system CPU

1. NIC also receives interrupt on incoming data.

< landll
< lland lll
< landlll

%* All of the given options ( page 40)
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241. While transmitting data from source A to destination B, 4 bits are changed during
the transmission then the erroris a

** Burst error ( page 22)

.0

% Single error

B

* Double error

DS

* Logic error

242. The switch that has no attached computers is called
Packet Switch

Exterior Switch

Interior Switch ( page 59)
External Switch

R/
0.0

R/
0.0

®
SR X4

o
*

243. is the most popular wiring scheme because of lowest cost.

5Base T

10Base T ( page 43)

100 base T

1000 base T

244, In technique, all members of the network can send data only on the
specific time slot?
% CDMA

% FDMA

* CSMA ( page 43)

TDMA

245. If a sender with a 100 Megabit NIC and receiver with 10 Megabit NIC wants to
communicate with each other at which speed they can communicate?
** 100 Megabit (page 40)
¢ 110 Megabit
«* 1000 Megabit

’0

s 10 Megabit
246. Missing in a frame format indicates receiving computer missed beginning of
the message.

R/
0’0

®.
SR X4

o
*

.
L4

o

DS

®.
%

¢

% eot
< soh ( page 16)
< sot
% eoh
247. The of errors is difficult than the of errors.

248. Source Independence phenomenon allows fast and efficient

DS

* Source Addressing

3

*

Routing

DS

* Packet Switching page 58

DS

* Store and forward

249. Indistributed route computation process each packet switch computes its routing
table locally and sends messages to the
“* Router
< Graph
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% Neighbors page 63
< WAN

250. The ___ layer of the OSI model takes the data from the physical layer and perform
error checking.
«* Transport

*

DS

* Data link google

DS

* Application

B

* Presentation

251. CBRstands for

Constant Byte Rate

Constant Bit Rate (page 71)
Connection break Recovery

3

*

%

AS

X3

*

R/
0.0

Constant Borrow Rate

252. A network that uses usually consist of a single long cable to which
computer attach.
«* Star Topology

** Ring Topology
+* Bus Topology page 26

o

% Bus and Ring Topology

253. If simultaneous transmission occurs, the frames interfere with each other and this
phenomenon is called

% packet loss
% collision page 28
+»* delayed transmission
+* coordination
254. In all computers are attached to a central hub
+* Ring topology
«* Star topology page 31

%

*

Hub topology

3

*

Bus topology

194) If you as a network administrator want to know the traffic flow of your data while
communicating with a remote computer which of the following will be used to know about
intermediate routers?

7

»  |p config

‘0

X3

%

Ping page 11
* Trace route

B3

)/
‘0

Arp

)

255. Basic LAN technologies such as Ethernet, Token Ring, and FDDlusea

» Connectionless service paradigm (, page 112)

» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm

» None of the given

256. protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
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» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84)

257. AnlInternet Address (IP address) is a unique binary number assigned to
a host and used for all communication with host

» 48-bit

» 32-bit (Page 85)

» 24-bit

» None of the given

258. The address identifies the physical network to which the computer is
attached, while the identifies an individual computer on that network.

P prefix , suffix (Page 85)

P suffix, prefix

P suffix , suffix

» None of the given

259. provides connectionless service.

» TCP

» UDP (Page 120)

> IP
» None of the given

260. UDP and TCP are both layer protocols

» Physical

» Data link

» Network

» Transport (Page 101)

261. Connection-oriented service, Point-to-point, Complete reliability, Full-duplex
communication, Stream interface, Reliable connection startup and Graceful connection
shutdown are the services provided by

> IP

» None of the given

» TCP (Page 123)

» UDP

262. ICMP message transport is acted upon by getting ICMP encrypted in IP.
» True (Page 117)

» False

263. Protocol addresses are abstractions provided by

» hardware

» software (Page 93)

» operating system

P internet

264. These packets serve same purpose on as frames on

» Intranet, LAN

» Internet, WAN

» Intranet, WAN
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» Internet, LAN (Page 101)

265. InIPv6 the type of address used for collection of computers with same prefix. Are
known as

» Anycast

» Unicast

» Multicast

» Non of the given (Page 114)

266. Special types of addresses in IPv6 used for multiple destinations; possibly not at

same site. Are known as

» Unicast

» Anycast

» Multicast (Page 114)

» Non of the given
267. UDP offers application programs a Message-Oriented Interface, applications can

depend on protocol to preserve data boundaries.

» True (Page 120)

> False

268. Reliability is the responsibility of the layer

» Network

» Datalink

» Transport (Page 123)

» Application

269. TCP uses mechanism to control the flow of data.

» door

» window (Page 126)

» acknowledgment

» retransmission

270. The time for acknowledgement to arrival of packet depends on.

P Distance to destination and Current traffic conditions (Page 125)
» Current traffic conditions

» Distance to destination

» none of these

271. FDDI can transmits data at a rate of ----------

» 100 million bits per second (Page 31)
» 10 million bits per second

» 1000 million bits per second

» None of the given

272. Computer networks are often called -------------- because they use packet technology.
» Ethernet

» Switch networks

» Packet networks (google)

» None of the given
273. is ideal in a situation where the group is small and all members are
attached to contiguous Local Area Networks.
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» Flood-and —Prune (Page 143)
» Configuration-and -Tunneling

» Core-Based Discovery

» None of the given

274. Router that decrements TTLto __ sends ICMP time exceeded message, with
router’s address as source address

> 3

> 2

> 1

» 0 (Page 118)

275.  Protocol addresses are abstractions provided by

» hardware

» software (Page 93)

P operating system

P internet

276.  Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient.

» True (Page 99)

> False

277. ARPis almost always used to bind a ___-bit IP addressto a___-bit Ethernet address.

» 32,48 (Page 98)

» 24,32

> 32,64

» 32,128

278. Inthe 1970s large organizations began to acquire multiple networks. Each network

in the organization formed island. Employees needed to choose a computer appropriate
for each task. So they needed multiple screens, keyboards and computers.

> False

» True (Page 81)

279.  Which of the following is a correct representation of the IPv6?

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255 (Page 114)

» 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255

280. Adatagram cannot be larger than of a network over which it is sent.
< MTU (page 107)
s Size

¢

% IP header
** None of the given
281.  Which of the following statement is true regarding ATM?

*,

¢

¢

7
*

It is a single technology for voice, video and data

L)

*

It has low jitter and high capacity.

K/
%

)/
‘0

It uses fixed size, small cells, 48 octet’s data
All of the above (page 72)

)

X3

¢
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282. TCP uses _format for all messages.

a. Single HO page 128

d. Double

e. Multiple

f. None of the given

283. The maximum segment size of TCP flow control is
a. 3000 octets
b. 2000 octets

c. 1000 octets HO page 126

e. None of the given

284.In TCP when a computer sends a segment, the and fields refer to
incoming data.

a. ACKNOWLEGE NUMBER, WINDOW book page 445

b. SEQUENCE NUMBER, WINDOW
c. ACKNOWLEGE NUMBER, SEQUENCE NUMBER

d. None of the given

285. is used for single destination computer.
a. Multicast
b. Broadcast

c. Unicast HO page 114

d. None of the given

286. Postfix defines how much of address used to identify network.
a. True
b. False HO page 103
287. Source is responsible for
fragmentation. a. [PV4
b. IPVé6 HO page 113

288.H.LEN shows the header length in units of
bits a. 34
b. 32 HO page 105
c. 30
d. None of the given
289. NAT stands for
a. Network Address Translation HO page 128
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d. Network Address Transmission
e. Network Address Test
f. None of the given
290. Serve Same purpose in Internet as frames on LAN
a. Packets
b. Virtual Packets HO page 101
f. Virtual Frames
g. Bothbandc
291.. The amount of buffer space available at any time is called the
window.
a. True HO page 126
b. False
292.. NEXT HEADER field in the base header defines type of
header it appears at the end of fixed-size base header.
a. True HO page 112
b. False
293.. uses window mechanism to control the flow of
data.
a. IP
b. UDP
c. TCP HO page 126
d. None of the given
294. The Header format of IPv6 is entirely different.
a. True HO page 111
b. False
295. UDP packet is encapsulated in datagram.
a. IP HO page 122
d. TCP
e. TCP/IP
f. None of the given

297..

298..

Reliability is not the responsibility of the Transport layer.

a.

True

b. False HO page 123
Twice NAT is another variant of NAT. it is used with site that runs
server. In this process NAT box is connected to Domain Name.

a.

False

b. True HO page 131
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299. . A popular use of ----------- is TCP Splicing. It interconnects two
independent TCP connections and performs segment rewriting.

a. NAT

b. NAPT HO page 131

e. Twice NAT

f. All of these

300. The goal of is to avoid adding retransmissions to an already
congested network.

a. Packet control
b. Congestion control HO page 128

e. Transmission control
d. None of the given

301. TCP stands for

a. Transport control protocol
b. Transmission control protocol HO page 123

g. Terminal control protocol

h. None of the given
302. IPV6 128 bits address includes network prefix and
a. Host Suffix HO page 114
d. Host prefix
e. Source Prefix
f. None of the given
303. TCP achieves by retransmission.
e. Efficiency
f. Accuracy

c. Reliability HO page 125
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d. None of the given
22. Class A mask 1s 255.0.0.0 which is used for

a. Unicasting
b. Multicasting

c. Subnetting HO page 103
d. All of the given

304. TCPisa

protocol.
a. Point-to-Point HO page 123

b. Multi-Point
c. Bothaand b
d. None of the given
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305. . There are possibilities to detect the destination using Trace-
route.
a. 1
b. 2 HO Page 118
c. 3

d. None of the given
306. . The UDP stands for
a. Universal Datagram Protocol
b. User Datagram Protocol HO page 119
c. United Datagram Protocol
d. None of the given

307. is less complex and easy to understand.
a. TCP
b. UDP HO page 120
e. IP

f. None of the given

308. In IPV6 the 128 bit addresses unwidely in dotted decimal; requires

numbers.
a. e
b. 14
c. 16 HO page 114

d. None of the given

309.. layer provides reliable delivery of datagram.
a
. Network HO page 104
b
. Transport
c
. Datalink
d

. None of the given




310.

AL-JUNAID TECH INSTITUTE

identifies the application program that sent the data.

a. Destination port
b. Source port Book page 445
c. Logical address

d. None of the given
311. . Preliminary version of IP was called

a. [P — New Generation (IPng)

b. IP — Next Generation (IPng) HO page 110
c. IP — Net Generation (IPng)

d. None of the given
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312. TCP connections are not called Virtual connections.

a. True
b. False HO page 123

313. Header contains all information needed to deliver datagram to the
destination computer. But which one of the following is not included:

a. Destination address
b. Source address
c. Rectifier HO page 102
d. Other delivery information
304.. TCP uses the term segment to refer to a
a. Packet
b. Message book page 444 HO page 128
c. Both (a) and (b)
d. None of the given

305. Twice NAT fails if an application uses the IP addresses instead of
Domain Name.

a. True HO page 132
b. False

306. sends ICMP echo messages with increasing TTL.
g. Ping

h. Trace route

c. Tracert HO page 118
d. None of the given
307.. IPv6 1s responsible for fragmentation. Routers simply drop

datagram's larger than network
a. Destination
b. Intermediate routers

c. Source HO page 113

d. Medium
308. . The Current version of IP-Version 4 is old
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a. 18 years
b. 20 years HO page 110

c. 22 years

d. none of given
309. . The process of learning the path MTU is known as path MTU discovery.
» True

» False
310. . UDP follows four types of interactions.

a. True HO page 121
b. False
311.. Routers use to forward datagrams along prearranged path.

a. Traffic class
b. Flow label HO page 111

c. Destination address

d. none of the given
312. . For , information about forwarding is stored in a routing table,

which is initialized at system initialization and must be updated as
network topology changes.

1=}

. Efficiency HO page 102

b. Security
c. Accuracy

d. Anomalies

313.. TCP provides reliable connection startup.

a. True
b. False HO page 123
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B encapsulates [P datagram as data area in hardware frame.

a. Network Interface Layer HO page 106

b. Datalink Layer
c. Network Layer

d. None of the given

315.. NAT software does not allow a PC to connect with the Internet and act
as a NAT device at the same time.

a. True

b. False HO page 132
- protocol uses three way handshake to begin a connection.
a. UDP

b. TCP HO page 127

c. IP

d. none of the given

317. MTU Stands for

a. Minimum transmission unit

b. Maximum transmission unit HO page 107
c. Multicast transmission unit

d. None of the given
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320.

321.

322.

323..

324..

325..

326..
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Fragmentation when using ICMP for path MTU should be avoided.

a. True HO page 118

b. False
System rebooting is one of the major problems in the reliable delivery

a. True HO page 124

b. False
Twice NAT requires the DNS to interact with the NAT device.

a. True HO page 132

b. False
The Universal Datagram Protocol is a message-oriented protocol.

a. True Wikipedia
b. False

Twice NAT allows a site to run servers.

a. True HO page 132

b. False
TCP provides ~~ communication.

a. Half-duplex
b. Full-duplex HO page 53

c. Both (a) and (b)

d. None of the given

Routing refers to the of routing information.

a. transmission
b. propagation HO page 133

Cc. communication

d. None of the given

Basic NAT does not work well to communication initiated from the internet.

a. True HO page 132

b. False
NAT device stores state information in translation table.




327

328

329

330

331

332..
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a. True HO page 130
b. False
.. HEADER LEN field gives size of extention header.
a. False
b. True HO page 112
.. UDP provides connection-oriented service.
a. True
b. False HO Page 120

. TTL stands for

a. Time to learn

b. Time to leave

c. Time to live HO page 105
d. None of the given
.. In TCP/IP,------------ provides reliable transport service.
a. IP
b. TCP HO page 123

c. Both IP and TCP

d. None of the given

.. The Universal Datagram Protocol is not an end-to-end protocol.

a. True

b. False HO page 120 (User Datagram protocol is end to end )
Protocol provides error reporting mechanism.

a. IGMP

b. SNMP

c. ICMP HO page 115

d. none of the given
.. Network Address Translation (NAT) requires device to perform

packet translation.
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a. True HO Page 128

b. False

334. UDP datagram format is -------------- bits.

a. 8
b. 16
c. 32 HO page 122

d. 64
335.. Which one is NOT the function of ping program

a. Traceability HO page 117
b. Reachability
c. Bothaand b
d. None of the given
336.. NAPT stands for .
a. Network Address and Protocol Translation
b. Network Address and Port Translation HO page 131
c. Network Address and Packet Translation

d. None of the given
337.. UDP uses best-effort delivery service.

a. True HO page 120
b. False
338.. ICMP message transport is acted upon by getting ICMP in [P

a. De-encapsulated
b. Encapsulated HO page 117

c. Segmented

d. none of the given
339.. identifies which application program on receiving computer

should receive the data.

a. Logical address
b. Source port
c. Destination Port Book page 445
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d. None of the given
340. . The Network Layer Protocol ICMP stands for
a. Instant Control Message Protocol
b. Internet Control Message Protocol HO page 115
c. Initial Control Message Protocol
d. None of the given

341. field tells the receiver how to order fragments within a given
datagram.
a. FLAGS
Book page
b. FRAGMENT OFFSET 375

c. IDENTIFICATION
d. None of the given

342.. contains all information needed to deliver datagram to the
destination.
a. Header HO page 102
b. Data Area

c. Identifier

d. none of the given

343. NAT is not useful at a residence with Cable Modem or DSL
connectivity. a. True

b. False HO page 132

344.TCP is a connectionless and reliable transport protocol.
a. True

b. False HO page 123
345. which is not the type of error messages defined by ICMP.

a. Source quench
b. Time exceeded

¢. Destination unreachable
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d. none of the given HO page 115

346. . Network Address and Port Translation (NAPT) is by far the most popular

form of

a. Network Address Transmission
b. Network Address Translation HO page 131

c. Network Address Transformation

d. None of the given

347. . Network having short intervals has a large timeout and the network
having large interval has short timeout.

a. True
b. False HO page 126

348. . One of the parameters, which motivated IP for change is address space. The
address space allows for over a million networks. But most

networks are class C and too small for many organizations.

a. 32-bit HO page 110
b. 128-bit
c. 16-bit
d. 64-bit
349. . Every hardware technology specification includes the definition of

the
maximum size of the frame data area, which is called the
Transmission Unit.

a. Least
b. Maximum HO page 107
c. Fragment
d. Frame
350. . -=m-mmmmmee- provides computer to computer communication.
a. IP HO page 119




351.
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c. ICMP

d. IGMP

. Address mask defines how many bits of address are in prefix.

» True
» False

352..

354..

shows senders preference for low latency, high Reliability.
a. TYPE

b. SERVICE TYPE HO page 105

c. SERVICE PRIORITY

d. None of the given

[P datagram can contains octets.

a. 0-65.535

b. 1-65.535 HO page 102
c. 1-65.536

d. none of the given

355. IPV6 address consists of

356.

a. 32 Bits
b. 64 Bits

c. 128 Bits HO page 111
d. none of the given

. End to End delivery Service of IP datagram is

a. Connection oriented
b. Connectionless HO page 101

c. Bothaandb

d. none of the given
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357.. The Source can configure outgoing datagram's to avoid

a. Segmentation

b. Defragmentation

c. Fragmentation HO page 118
d. None of the given
358. . is a technique used to Limit datagram size to small MTU of any
network

a. Segmentation
b. Fragmentation HO page 108

c. Encapsulation

d. None of the given

359.. Message is sent in response to incoming datagrams with
problems.
a. TCP/IP
b. IGMP
c. ICMP HO page 117

d. none of the given
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360. . Which protocol is used to test different tools.

a. ICMP HO page 117

b. IGMP
c. TCP/IP

d. none of the given

361. . Due to revolutionalization of IP-V6 the speed has increased from

a. 56kbps to 512kbps

b. 512kbps to 1gbps

c. S56kbps to 1gbps HO page 110
d. none of the given
362.. field of header indicates whether a datagram is a fragment or a

complete datagram.
a. FLAGS Book page 373
b. FRAGMENT OFFSET

c. IDENTIFICATION

d. None of the given

363. . In 3-way handshake TCP requires to generate a random sequence
number.
a. 30 bit
b. 32 bit HO page 127
c. 34 bit

d. none of the given
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370.

AL-JUNAID TECH INSTITUTE

. IPV6 addresses are bits.
a. 32
b. 64
c. 128 HO page 111
d. 256

. The time for acknowledgement to arrive depends on

a. Distance to destination

b. Current traffic conditions

c. Bothaandb HO page 125

d. none of the given
is a type of address used for collection of computers with same prefix.

a. Cluster HO page 114

b. unicast
c. Multicast

d. none of the given
field is used to identify a specific path through the network

a. FLOW LABEL HO page 111

b. TRAFFIC CLASS
c. Bothaandb

d. none of the given

. TCP is not connection-oriented service.

a. True
b. False HO page 123

371.. IPV6 address with leading zeros is interpreted to hold an [PV4
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address.
a. 96 HO page 114
b. 100

c. 120

d. none of the given

372. A datagram cannot be larger than of a network over which it is
sent.
a. MTU HO page 113
b. Size
c. IP header

d. None of the given
373.
A Relies on the hardware manufacturer to assign a unique physical address to each network interface.

P> Static addressing scheme (Page 34)
P Configurable addressing scheme
» Dynamic addressing scheme
» None of the given
374. An interface for thin Ethernet must have an connector, and must enerate signals according to the
specification.

» RJ-45,10Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2 (CS610 Reference Book , Page 21)
» BNC,10Base T
374. A system with redundant bridges might have a problem with in the system.

» Loop

P Filters

P Spanning Trees
P All given choices

375. A Bridge can
P Filter a frame
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» Forward a frame
P a LAN Do all the Click here for detail
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376. is used for typical data applications (where the data rate may be unknown and bursty) and allows useof

whatever bandwidth is available at a given time.

» Constant Bit Rate (CBR) service

» Variable Bit Rate (VBR) service

> Available Bit Rate (ABR) service (Page 71)
» None of the given

377. ATM assigns each VC a identifier that is divided two parts to produce a hierarchy.

» 21-bit
» 22-bit
» 23-bit
> 24-bit (Page 67)

378. of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layer (Page 84)
» Network Interface Layer

» Internet Layer

» Transport Layer

379.

places the boundary between the second and third octets

» Class A

» Class B (Computer Networks and Internets, page235)
» Class C
» Class D

380. UDP and TCP are both layer protocols

» Physical
» Data link
» Network
» Transport (Page 101)

381. Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided
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» None of the given

> IP

» TCP (Page 123)

» UDP

382. protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84)
383.

identifies which application program on receiving computer should receive the data

» Logical address
» Source port
» Destination Port (Computer Networks and Internets, page313)

» None of the given
384.

identifies the application program that sent the data.

P Destination Port

» Source port (Computer Networks and Internets, page313)
» Logical address

» None of the given

385. Which of the following are interior routing protocols?

» RIP

» OSPF

» BGP

» RIP and OSPF

386. The Border Gateway Protocol (BGP) uses for all communication

» UDP
» TCP |
» Both UDP and TCP
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» All of given
387.

measures distance in network hops, where each network between the source and destination countsas
single hop.

» BGP

» OSPF

> RIP (Page 138)
» None of the given

388. OSPF is based on___

» Distance vector routing

» Link state routing (Page 140)

» Path vector routing

» Distance vector routing and Link state routing
389.

performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one siteon the
Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP) (Page 144)

» Core Based Trees (CBT)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)

» Protocol Independent Multicast _ Dense Mode (PIM-DM)
390. The length of time required to send a variable length packet is variable and does not require a complicated
interrupt scheme to detect completion of transmission.

» True
» False (Page72)

391. NEXT HEADER field in the base header defines type of header and it appears at end of fixed-size base header.

» True (Page 112)
P> False

392. Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.

» True (Page 99)

> False

393. A computer attached to a given network can only communicate with other computers attached to the same
network. Is this a problem with multiple networks?
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» True (Page 81)

» False
394. In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards
and computers.

> False
» True (Page 81)

395. The term self-identifying is used for Classful IP addresses because the class of the address can be computed
from the address

P itself (Page 87)

» prefix

» suffix

» mask
396. In which method of Address Resolution Protocol the protocol address independent of hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T,C

» D

> C

> T,D (Page97)

397. In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T
» D
» C (Page97)
> T,C
398. Reconstruction of original datagram is called reassembly.

» True (Page 28)
» False

398. A computer needs a complete stack of protocols to run either a client or a server.

» True (Computer Networks and Internets, page 344)

> False

399. TCP uses__mechanism to control the flow of data.
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» door
» window (Page 126)

» acknowledgment

P retransm ission
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400. In Direct point to point communication adding the Nth computer requires---------------

None of the given
2

BN

> N-1 (Page23)
(N2 -N)/2

401. In ------------ , hetwork occupies the smaller area like a room a floor or a building
» LAN (Page4)
WAN
MAN

None of the given

new connections.
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402. The third field of the header consists of------ bit Ethernet frame type.

48
32
16
28

403. The maximum size of an Ethernet segmentis

=

250 meters

500 meters

700 meters

None of the given

404. The network with Throughput T and Delay D has a total bits in transit at a time.

D+T
>»D-T
DXT (Computer Networks and Internets, page203
D/T
405.

places the boundary between the first and second octets

» Class A (Computer Networks and Internets, page235)
Class B
Class C
Class D

407. Router detects datagram --------- than network MTU and then it splits into pieces and each piece is ---------------

outbound network MTU.

» Larger, smaller (Page 108)
Larger, larger

Smaller, larger

Smaller, smaller

408.Connectionless service, Message-Oriented protocol, best-effort delivery service, arbitrary interaction &

operating system independent are the characteristics of
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» UDP (Page 120)
IP

TCP

None of the given

409. ----------- provide Application to application communication it also called end to end communication
IP
> TP (Page 119)
RIP

None of the given
410. A routing table contains

The destination network ID
The hop count to reach the network
» The router ID of the next hop (Page 102)
All of the given
411.Which of the following protocols allows the sender and receiver to enforce polices.

RIP
OSPF
> BGP (Reference Book 347)
RIP and OSPF
412. measures distance in network hops, where each network between the source and destination countsas

single hop.

BGP

OSPF

» RIP (Page 138)
Non of these

413. includes a 32-bits address mask with each address, which allows the address to be classful, classless,or
subnetted.

RIP

» OSPF (Page 140)

BGP

None of the given
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414. One repeater --------------- , two repeaters ------------------- the maximum cable length limitation.

» Double, triple (Page 49)
Double, 4 time
half, triple
Double, half
415. ICMP message transport is acted upon by getting ICMP encrypted in IP.

* True (Page 117)

False
416. Like most application programs, a client and server use a transport protocol to communicate.

» True (Page 146)
False
417. Mapping between a protocol address and a hardware address is called Address Resolution.

» True (Page 93)
False

418. Address mask defines how many bits of address are in suffix?

True
» False (Page 103)
419. A single networking technology is best for all needs.

True

» False (Page 81)
420. In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens,
keyboards and computers.

» False
» True (Page81) rep
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421. Router detects datagram ---- than network MTU

» Larger (Page 108) rep
» Smaller
» None of given
» Equal
422. Information can flow in either or both direction between

» Clients

» Clients and servers (Computer Networks and Internets, page 344)
P Servers

» None of given

423. On of the design goals for unicast route propagation is

P consistency
P inconsistency
> stability (Computer Networks and Internets, page 344)
» dynamic addressing
424. IPV6 address consists of

» 32 Bits

» 64 Bits

> 128 Bits (Page 128)

» none of the given
424. UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to
preserve data boundaries.

» True (Page 120)
» False
425. In case TCP, retransmission, acknowledgment from a computer on LAN are expected to arrive within

Seconds

Micro seconds

Milliseconds Click here for detail
Nanoseconds

=
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426. Twice NAT is another variant of NAT. it is used with site that runs server. In this process NAT box is
connected to Domain Name.

» True (Page 131)
» False
427. A network uses a --arranges for computers to be connected in a closed loop.

» Star Topology
» Ring Topology (Page 25)
» Bus Topology
» None of the given
428.Protocol addresses are abstractions provided by

» hardware

» software (Page 93)
P operating system

P internet

429. In Direct point to point communication adding the Nth computer requires --------------- new connections.

» None of the given
> N2

> N-1 (Page 23)
» (N2 -N)/2
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430. In Point-to-Point topology there are two topologies.

» Tree and Ring

» Star and Ring

» Star and Tree (Page5)

» None of the given

431. In----—----- , network occupies the smaller area like a room a floor or a building

» LAN (Page4)

» WAN

» MAN

» None of the given

432. Hardware that calculates a CRC uses two simple components.

» AND unit and XOR unit

» Shift register and XOR unit (Page 20)

P Shift register and AND unit

» None of the given

433. CRC can detect more errors than a simple checksum.

> true (Computer Networks and Internets, page 80)
» false
434. The Gigabit Ethernet hardware operates at a rate of --—-----

» 10 Mbps

» 100 Mbps

» 1000 Mbps  Click here for detail

» None of the given

435.Formally named informally known as the twisted pair Ethernet or TP Ethernet.

» 10 Base 2

» 10 Base 5

» 10 Base T (Page 43)
» None of the given
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436. An interface for thin Ethernet must have an connector, and must generate signals according to
the specification.

» RJ-45,10 Base T

» RJ-45,10 Base 5

» BNC, 10 Base 2 ( ¢s610 reference book Page 201)
» BNC, 10 Base T

437. A system with redundant bridges might have a problem with in the system.
» Loop rep
» Filters

» Spanning Trees
» All given choices
438. computes shortest paths in a graph by using weights on edges as a measure of distance.

» Greedy algorithm
» Distance vector algorithm

» Dijksta’s algorithm (Computer Networks and Internets, page 112)
» Non of the given
439. Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a

» Connectionless service paradigm  (Computer Networks and Internets, page 112)
» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm

» None of the given

440.____ protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84) rep
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441. An Internet Address (IP address) is a unique binary number assigned to a host and used for all
communication with host

» 48-bit
» 32-bit (Page 85)
» 24-bit
» None of the given
442.  places the boundary between the first and second octets

» Class A (Computer Networks and Internets, page 235)
» Class B
» Class C
» Class D

443. places the boundary between the third and fourth octets.

» Class A
» Class B

» Class C  (Computer Networks and Internets, page 235)
» Class D

444. field of header indicates whether a datagram is a fragment or a complete datagram.

» FLAGS Click here for detail
» FLAGMENT OFFSET

» IDENTIFICATION

» None of the given
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445. provides connectionless service.
» TCP
» UDP (Page 120)
> IP

» None of the given

446.UDP and TCP are both_ layer protocols

» Physical
» Data link
» Network
» Transport (Page 101) rep
447.Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided

by

> IP
» None of the given
» TCP (Page 123) rep
» UDP
448. _protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer
EINetwork Interface Layer

» Internet Layer
» Transport Layer (Page 84) rep
449. identifies which application program on receiving computer should receive the data

» Logical address

» Source port

» Destination Port (Computer Networks and Internets, page313) rep
» None of the given
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450.

identifies the application program that sent the data.

» DestinationPort

» Source port (Computer Networks and Internets, page313) rep
» Logical address

» None of the given

451.The Border Gateway Protocol (BGP) uses for all communication
» UDP
> TCP rep

» Both UDP and TCP
» None of the given
452.Which of the following protocols allows the sender and receiver to enforce polices.

» RIP
» OSPF
» BGP (Reference Book 347) rep
» RIP and OSPF
453. uses distance vector approach to define routing

» BGP
» OSPF
> RIP (Computer Networks and Internets, page332)
» None of the given
454.1ICMP message transport is acted upon by getting ICMP encrypted in IP.

» True (Page 117)
> False
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455.Protocol addresses are abstractions provided by

» hardware
» software (Page 93) rep
» operating system
P internet
456.These packets serve same purpose on as frames on

» Intranet, LAN
» Internet, WAN
» Intranet, WAN
» Internet, LAN (Page 101)
457.Address mask defines how many bits of address are in suffix?

» True
» False (Page 103) rep
458.A single networking technology is best for all needs.

» True
» False (Page 81) rep
459.A computer attached to a given network can only communicate with other computers attached to the

samenetwork. Is this a problem with multiple networks?

» True (Page 81)rep
» False
460.

The term self-identifying is used for Classful IP addresses because the class of the address can be computedfrom
the address

» itself (Page 87)
» prefix
» suffix
» mask
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461.Find the class of the address.

10100111 11011011 10001011 01101111

> A
» B (Computer Networks and Internets, page 122)
> D
> C

462.Find the class of the address:
11110011 10011011 11111011 00001111

> A
P E(Computer Networks and Internets, page 122)
» C
> B

463.In which method of Address Resolution Protocol the protocol address is determined by hardware
address?Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T

» D

» C (Page97) rep
> T,C

464.Which method of Address Resolution Protocol requires hardware broadcast?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» D (Page97)
> T

> C

> T,D
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465.Which method of Address Resolution Protocol resolution with minimum delay?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» T,D

> c

> T

» T,C (Page97)

466.In which method of Address Resolution Protocol the implimentation is more difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T,C

> T

> C

» D (Page97)

467.0n of the design goals for unicast route propagation is

» Consistency
P inconsistency
P stability (Computer Networks and Internets, page 344) rep
» dynamic addressing
468.Propagation multicast routing information differs dramatically from unicast route propagation?

» True (Computer Networks and Internets, page 335)
> False
469.The IP multicast abstraction allows an application running on an arbitrary computer to leave a multicast group

at any time. While application on a computer remain a member of a group.

» One or more
» only one

» no

» many
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470.To save traffic, an EGP does not summerize routing information from the autonomous system before passing it
to another autonomous system.

» True
» False (Computer Networks and Internets, page 329)
471.In IPv6 the type of address used for collection of computers with same prefix. Are known as

» Anycast
» Unicast
» Multicast
» Non of the given (Page 114)
472.Special types of addresses in IPv6 used for multiple destinations; possibly not at same site. Are known

as

» Unicast
» Anycast
» Multicast (Page 114)
» Non of the given
473.UDP offers application programs a Message-Oriented Interface, applications can depend on protocol

topreserve data boundaries.

» True (Page 120) rep
> False
474.Reliability is the responsibility of the layer

» Network
» Datalink
» Transport (Page 123)

» Application

475.We use the term to refer to a measure of the path that routing software use when choosing a route.

routing path
routing metric
routing (Computer Networks and Internets, page330)

switching
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476.TCP uses mechanism to control the flow of data.

477. door
» window (Page 126) rep
» acknowledgment
P retransmission
TCP uses window mechanism to control the flow of data.

478.The time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions (Page 125)
» Current traffic conditions

» Distance to destination

» non of these

479.FDDI can transmits data at a rate of ----------

» 100 million bits per second (Page 31)
» 10 million bits per second

» 1000 million bits per second

» None of the given

480.

Computer networks are often called -------------------- because they use packet technology.

» Ethernet
» Switch networks
» Packet networks (Computer Networks and Internets, page 73)
» None of the given
481.A network uses a arranges for computers to be connected in a closed loop.

» Star Topology
» Ring Topology (Page 25) rep
» Bus Topology
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» None of the given

An---m-memeeeeee- method, the network hardware designers specify how type information is included in the frame

and the value use to identify various frame types.

» Explicit frame type (Computer Networks and Internets, page 108)
» Ideal frame type
» Implicit frame type
» None of the given
483.An interface for thin Ethernet must have an connector , and must generate signals according tothe

specification.

» RJ-45,10Base T
» RJ-45, 10 Base 5
» BNC, 10 Base2  (cs610 reference book Page 201) rep
» BNC, 10 Base T
484.A Bridge forwards or filters a frame by comparing the information in its address table to the frame’s

» Layer 2 source address

» Source node’s physical address

» Layer 2 destination address Click here for detail
» Layer 3 destination address

485.Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing
is called

» Hierarchal address

» Default route (Computer Networks and Internets, page 172)
» Shortest path

» None of the given

486.__ of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layer (Page 84) rep
» Network Interface Layer

» Internet Layer

» Transport Layer
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487. protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84) rep

488. is called an end-to-end protocol because it provide a connection directly from an application on one
computer to an application on a remote computer.

IP
UDP
> TCP (Computer Networks and Internets, page 306)
» None of the given
489. uses distance vector approach to define routing

» BGP
» OSPF

» RIP (Computer Networks and Internets, page332) rep
» None of the given

490. is ideal in a situation where the group is small and all members are attached to contiguous Local
Area Networks.

» Flood-and —Prune (Page 143)
» Configuration-and -Tunneling
» Core-Based Discovery
» None of the given
491.Router that decrements TTL to sends ICMP time exceeded message, with router’s address as source address

> 3
> 2
> 1
» 0 (Page 118)
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492.Protocol addresses are abstractions provided by

» hardware

» software (Page 93) rep
P operating system

P internet

493.Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly
inefficient.

» True (Page 99) rep
> False
494.ARP is almost always used to bind a_-bit IP address to a -bit Ethernet address.

> 32,48 (Page 98)
» 24,32
> 32,64
Phad2, W28
495.In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens,
keyboards and computers.

» False
» True (Page 81) rep

496.In which method of Address Resolution Protocol the protocol address is determined by hardware
address?Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

Types of

Features Resolution
Use full with any hardware T
Address change affects all hosts | T
Protocol address is determined | C
by hardware address

> T

» D

» C (Page97) rep
> T,C
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497.. The general form of an IP datagram is with a header followed by data. The header contains information

thatcontrols where and how the datagram is to be sent.

» True (Computer Networks and Internets, page 332)
> False
498.To save traffic, an EGP does not summarize routing information from the autonomous system before passing it

to another autonomous system.

» True
» False (Computer Networks and Internets, page 329)

499.Which of the following is a correct representation of the IPv6?

> 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255  (Page 114)
» 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255
» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256
» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255
500.The number of connections needed for N computer in direct point to point communication is equal to:

» (N2 -N)/2 (Page 23)
N(N- 1)
B N?
B None of the given
501.When an application --------- data, it makes a copy of the data available to all other computers on the
network.

=l

Broadcasting
Multicasting
Unicasting

None of the given

502.I1n which method of Address Resolution Protocol the protocol address is determined by hardware address? Were
"T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

B M M
o o -

(Page 97) rep

=
A
(@]
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503. Ethernet uses a bit static addressing scheme in which each device is assigned a unique address by the

manufacturer.

64
> 48 (Computer Networks and Internets, page 109)
32
8
504.A system with redundant bridges might have a problem with in the system.

=l

Loop Click here for detail rep

Filters

Spanning Trees

All given choices

505.The product of delay and throughput measures the___of data that can be present on the network.

Area
» Volume (Page 80) rep
Length
None of the given
506.Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction

andoperating system independent are the characteristics of

TCP
» UDP (Page 110)
IP
None of the given
507.Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided

by

None of the given
» TCP ( Page123) rep
uDP
IP
26
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508.The process of using a routing table to select a next hop for a given datagram is called

Encapsulation
Reassembling

» Routing or forwarding (Computer Networks and Internets, page 265)
None of the given
509. uses distance vector approach to define routing
BGP
OSPF
» RIP (Computer Networks and Internets, page332) rep

None of the given
510.A multicast routing scheme in which the protocol software builds a delivery tree from a central point is
called

Distance Vector Multicast Routing Protocol (DVMRP)
» Core Based Trees (CBT) (Page 114)
Protocol Independent Multicast_ Sparse Mode (PIM-SM)
Protocol Independent Multicast _ Dense Mode (PIM-DM)
511.0ne repeater__, two repeaters the maximum cable length limitation.

doubles, cancel
» doubles, triple (Page 49) rep
square roots, cude roots
and, triple
512.Whenever it handles a packet, IP software needs to separate the destination address into a and

postfix, Infix

non of these

Infix, prefix

» prefix, suffix (Page 87)
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513.. Although message exchange can be used to bind addresses, sending a request for each binding is

hopelesslyinefficient.

» True (Page 99) rep
False

514.ARP is almost always used to bind a-bit IP address to a -bit Ethernet address.

> 32,48 (Page 98)
24, 32
32,64
32,128
515.End-to-end delivery service is connection oriented.

True
> False (Page 101)
516.A single networking technology is best for all needs.

True
» False (Page 81) rep

517.In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens,

keyboards and computers.

False

» True (Page 81)
518.Which method of Address Resolution Protocol is useful with any hardware?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

(Page 97)
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